
----- Ver.10.9.9 -----   July 22, 2007 
 
(1) Utility for specification of SIMOMM layers in WinGamess/Tinker(MM3) SIMOMM and 

automatic generation of input file for the calculation. 
 
 
 
 
 
 
 
 
 
 
 

Select "SIMOMM Layers" in 
Calculation menu to open the control 
panel. To assign SIMOMM layers, 
select layer in the panel and click atom 
in the main window. Atoms assigned to 
High Layer are shown in a red box. 
Atoms which are not in a red box are 
assigned to Low Layer. (In the example, 
six carbon atoms of the aromatic ring 
are set to High Layer.) To define 
SIMOMM layer, click Apply button. 

 
 To execute WinGamess/Tinker(MM3) 

SIMOMM calculation, select "WinGamess" in 
Calculation menu, make a checkmark on 
SIMOMM and execute. Input file which 
requires $TINXYZ and $LINK data is 
automatically generated.  

 
 To load the structure of QM/MM whole 

molecule, use "Load New WinGamess Output 
for Bulk Model in SIMOMM Calc. " in the File 
menu. To load QM part only, load Gamess 
output as usually. 

 
(2)  New version of batch utilities for drag-and-drop execution of GAMESS are released. 
 

PCG_DDE.bat  ( for PC GAMESS )  
WG_DDE.bat  ( for WinGamess ) 
 
To execute GAMESS calculation, drag-and-drop input file(s) on it.  
It accepts up to 9 GAMESS inputs and sequentially executes them. 

 
(3)  If you click multi display (see Facio 10.9.7) or multi MO display (see Facio 10.7.1), molecular 

model or MO lobe in the multi display is now shown in the main window. 
 
(4)  For animation representation of normal mode vibration, movement of atoms is modified so 

as to be symmetrical to the equilibrium position. According to this change, the parameter 
"Frames per half cycle" is restricted to odd number. 

 
(5)  Default values of BondCriterion and HX_Max are changed to 2.1 and 1.5, respectively. 

These parameters determine the existence of bond between atom X and atom Y. In case that 
both X and Y are non-hydrogens, BondCriterion is used. HX_Max is the parameter when 
either X or Y is hydrogen. 



----- Ver.10.9.8 -----   July 6, 2007 
 
(1) Energy changes during optimization are shown as a graph, such as below.  
 

With this tool, you can recognize how geometry optimization proceeds and find abnormal 
behavihor in SCF calculation, which causes difficulty of convergence. 
Select "Summarize Energy Changes During Optimization" in Miscellaneous menu. This menu 
item is enabled whenever output file of GAMESS or Gaussian are loaded. 
Y-amplitude slide bar set the magnifying factor of the graph. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click energy value in the box located at the right side, a red vertical line appears. 
This vertical line indicate where the energy corresponds to the point in the graph. If you drag a 
mouse in the energy value list, the red vertical line moves accordingly. 

 
 
(2) Output file of Gaussian 90 and 94, which is different from Gaussian 98 and 03 can be read at 

least for optimized geometry. Reading of other type data are not garanteed, since the author of 
Facio does not have any output files or checkpoint files of Gaussian 90 and 94 to test. 

 
 
(3) New version of Drag-and-drop execution utility for PC GAMESS (Multi_DDEG3.bat) are 

released.  To start PC GAMESS calculation, drag-and-drop input file(s) on it.  
It accepts up to 9 PC GAMESS inputs and sequentially executes them. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Multi_DDEG3.bat 

Drag 
 & 
Drop 

After Facio 10.9.9,  

PCG_DDE.bat  (for PC GAMESS)  

          and  

WG_DDE.bat  (for WinGamess).  



 
----- Ver.10.9.7 -----   June 16, 2007 
 
(1) Multi display as show in the screen shot below has been implemented. 

Select "Load New Multi File" in the File menu. "Load New Multi File" panel will appear. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

To the list box of this panel, you can drag-and-drop up to 10 PDB, CC1, free formatted or 
WebLab XYZ, MDL mol, Tripos mol2, TINKER XYZ, GAMESS output and Gaussian output 
and mixture of them.  If you lick "Load All" button, then listed molecules will be shown in the 
multi display. The movement of the molecule in each sub window is synchronized with that of 
the main window. 
Sizes and positions of multi display are automatically saved in MultiDisp.ini file at Facio's root 
folder, when you close the Load New Multi File panel with Close button. 
 
If there are display problems, please try to set graphics hardware acceleration back.  
It will fix the problem. 

 
 
(2) Slight modification of the GUI in GAMESS Input Option panel 
 

(a) "Clear button" for IFREEZ input field 
(b) SOLVNT parameter of PCM calculation 
(c) Text box for setting base file name of the calculation to be executed. 
 
 

(3) Graphics format for saving scree shot are now PNG and Bitmap. In the previous version, these 
were JPEG and Bitmap. You can set the default value with isPNG parameter in Facio.ini. 

    asPNG=1  (default format is PNG)     asPNG=0  (default format is Bitmap) 
 
 
(4) Initial magmification is set by the parameter EyeZdiff in Facio.ini. 
    EyeZdiff=0  (default,  maximum zoom-in level)   (0 <= EyeZdiff <= 400) 
 
 



 
----- Ver.10.9.6 -----   May 12, 2007 
 
(1) Detection and visualization of hydrogen bonds are implemented. 
 
   Criteria for detection are as follows. 
 
   X --- H .... A      ( Atom X = N, O, F, Cl, Br, I  and atom A = N, O, F, Cl, Br, I, S ) 
 
   (a)    HX_Max  <  Length ( X .... A )  <=  H_BondCriterion    
   (b)   H_BondAngleCriterion  < Angle ( X --- H .... A ）<=  180 degrees 
 
      Default values : 
      HX_Max = 1.3 Angstroms  H_BondCriterion = 2.5 Angstroms   
      H_BondAngleCriterion = 90 degrees 
 
 

Detection of hydrogen bonds is automatically performed whenever new molecular structure 
loaded.  If you check "Show Hydrogen Bonds" in the Miscellaneous Menu, hydrogen bonds 
are displayed as lines. See the screen shot below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

"Dump Hydrogen Bonds" in the Utilities Menu will output hydrogen bonding data (sequential 
number, hydrogen bond length, and so on) as text file. 

 
 
 
(2) Using Bondi's van der Waals radii and the equations below, van der Waals volume can be 

caclulated. 
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(3) XYZ format of WebLab ViewerLite is now a supported molecular structure file. 
 
 



 
----- Ver.10.9.5 -----   April 27, 2007 
 
(1) Simulated IR, Raman and VCD spectra can be saved as text file in three resolutions : 
   COARSE ( 5cm**-1), MEDIUM ( 1cm**-1) and FINE ( 0.1cm**-1). 
   COARSE is the resolution of Facio's spectrum window. 
 
(2) Additional parameter for TINKER/MM3 are newly produced in order to make molecular 

mechanics calculation of esters, carbonates and carboxylic acids possible. These parameters 
are not optimized but will be useful for modeling of medium-sized lactone or polycarbonates. 

 
Please append the contents of "Additional_MM3PRM.txt" to mm3.prm. 

 
(3) Up to the previous version, MOPAC versions of FORCE calculation which Facio can read 

were MOPAC2000, MOPAC93, MOPAC6, WinMOPAC3.0, 3,5 and 3.9. Each version of 
MOPAC has a different output format of FORCE calculation. Now Facio supports 
MOPAC2007, which has another different format. 

 
(4) Facio visualizes molecular orbitals of MOPAC2007. Since Facio can generate graphics data 

without using PSI-88, input key word, GRAPH is not required for MO visualization. 
 

After geometry optimization, Facio can automatically load molecular orbital coefficients from 
output file.  So, you can visualize HOMO only with two mouse-clicks! 

 
             1.  evoke MO viewer  -----  2.  show MO  
 

For loading MO coefficients, the only supported version of MOPAC is MOPAC2007.  
 
 
 
 
----- Ver.10.9.4 -----   April 12, 2007 
 
(1) Solvent-excluded surface volume and area calculated by MSMS are shown. 
 
(2) If you utilize EM64T feature of CPU for PC GAMESS, set EM64T=1 in Facio.ini. 
 
 
 
----- Ver.10.9.3 -----   April 7, 2007 
 
(1) PC GAMESS input options which are useful for MRMP2 calculation are automatically set. 
 
(2) PC GAMESS input option which enables EM64T feature of CPU is automatically set. 
 
(3) Bug related to energy levels representation of ROHF calculation has been fixed. 
 
 
 
 
 
 
 
 
 
 
 
 
 



----- Ver.10.9.2 -----   April 1, 2007 
 
(1) Energy levels of alpha and beta MO in UHF 

calculation can be separately displayed.  
 
(2) TDDFT calculation is possible in 

WinGamess , VERSION =  7 SEP 2006 
(R4). GUI for this is implemented. 

 
(3) Original folder icons are included.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
----- Ver.10.9.1 -----   March 14, 2007 
 
(1) GUI for relaxed PES Scan (Potential Energy Surface Scan) calculation of PC GAMESS is 

newly implemented. It can permit you to set parameters for two dimentional scan. To visualize 
energy profile of PES and the corresponding structures, use Tool Menu >> PES Scan Data 
Viewer. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
   GUI is not available for WinGamess, since it is not able to perform PES Scan along internal 

coordinate of bond angle and dihedral angle. 
 



 
(2) Models of gas hydrate skeleton are included as sample. They were modeled with Facio from 

scratch. Corresponding imaginary polyhedranes, which are intermediate of the models, are 
also included. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
----- Ver.10.8.1 -----   February 4, 2007 
 
(1) New feature of loading more than one Gaussian cube MO is implemented. 
   Select "Load Gaussian Cubes for MOs (in Multi File Drag-and-Drop Mode) to open 
   list box window. To this window, drag-and-drop Gaussian cube MO(s). Then click "Load All" 

button. Then use CUBE/Molecular Orbital Viewer in Tools Menu.  This is very convenient 
feature when you want to view only selected MOs. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
(2) New feature of generating sequential Gaussian cube MOs is implemented. 
   See Gaussian Utilities in Tools menu. Load formatted checkpoint, check "Generate Sequential 

Cube MOs, and set the range of MO by specifying "From" and "To" parameters. Then click 
"Execute" button to generate cube MOs. Each cube data is saved as a separated file with MO 
number attached automatically to the file name. 
(CubeGen radio button is automatically checked, if formatted checkpoint is loaded before.) 

 
(3) Molecular geometry can now be retrieved from Gaussian formatted checkpoint file. 
 
 
 
 

 

Type I Type II Type H

Drag & drop Gaussian cube MO 

files to the window. 



 
----- Ver.10.7.1 -----   January 17, 2007 
 
(1) Up to 20 MOs can be viewed simultaneously. (See the screen shot below) The movement of the 

molecule in each sub window is synchronized with that of the main window. Each MO can also 
be automatically saved as bitmap files. The position and size of sub windows are automatically 
stored in MultiMO.ini at Facio's root folder.  

 

 
 
 
 
(2) View point controller is implemented. See Utilities menu. This numerically changes the view 

point of the molecule. You can also lock the view point. 
 
(3) Up to ver. 10.6.2, double run of Facio has been intentionally prevented. But now multi run of 

Facio is allowed. This is very useful for viewing many molecules at the same time. 
 
 
 
----- Ver.10.6.2 -----   December 10, 2006 
 
(1) Drag & drop execution utility for PC GAMESS (DDEG4.bat) is now released. 
 
(2) Bug related to NMOFZC in $MCQDPT of GAMESS input option is fixed. 
 
(3) SYMLOC=.TRUE. and MVOQ=6 are automatically set when LOCAL=BOYS or POP  
   and GROUP is other than C1. 
 
 



 
----- Ver.10.6.1 -----   November 23, 2006 
 
(1) Atom number reassigning utility 
   In order to use this utility, select "Assign Atom Numbers" in Utilities Menu. 
   Set the "Start From" parameter (default=1), then click atoms of which just you want to 

change the number and finally click the "Assign Atom #" button. You don't have to click all 
the atom. The numbers of the atoms which are not clicked are automatically reassigned.  

 
(2) GUI for PC GAMESS can now make an input for MRMP2 calculation. 
   Input options are automatically included to speed up integral transformation & effective Fock 

matrix construction steps, which dominates the overall cost of CI and MCSCF calculation. 
 
(3) GUI for changing Arrow properties.  

Arrow is used to represent normal mode vibration or dipole moment. 
 
(4) Schematic representation of MO energy levels can now be saved as PostScript file. 
 
(5) GUI for MOPAC.  
 
 
 
----- Ver.10.5.1 -----   October 8, 2006 
 
(1) Full revision of OpenGL-graphics rendering routines has dramatically lowered CPU usage. 
 
(2) Drag & Drop operation is supported for loading structure files. Supported file types are PDB, 

CC1, CC2, free-formatted XYZ, MDL Mol, Tripos Mol2, GAMESS output and Gaussian 
output. 

 
(3) MDL Molfile and Tripos Mol2 files can now be used as input files. 
 
(4) FORCE calculation data of MOPAC93 and MOPAC2000 can be read to show normal mode 

vibration as animation.  MOPAC6, WinMOPAC3.0, 3.5 and 3.9 were already supported in 
Facio 9.8.3. 

 
(5) Dipole moment are shown as an arrow. 
 
 
 
 
 
----- Ver.10.4.1 -----   August 21, 2006 
 
(1) Arbitrary cross section of MO can be shown as contour plot with a help of GNUPLOT. 
   Contour plot shown below is a cross section of C60 's LUMO.  
   Samples are included in the folder "CubeMO_CrossSection". 
 

To Linux user :  Set write permission for the directory where GNUPLOT executable resides. 
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In order to superimpose wire model of the molecule to the contour 
plot of the cross section, appropriate software, such as Illustrator is 
required. 

 
(2) Gaussian input file for Multi-Step Job is supported. 
 
(3) Custom route section for Gaussian can be set up to 30 items and shown as list. 
 
(4) Under symmetry restricted condition, there was a bug in automatic setting of parameter 

NMCC in $GUGA group and parameter NELS in $DET group. The bug has been fixed. 
 
(5) Compression format of Facio's distributing archive has been changed to ZIP for Linux user's 

convenience. 
 
 
----- Ver.10.3.1 -----   May 27, 2006 
 
(1) Schematic representation of MO energy levels is implemented for GAMESS. 
 
(2) Atom sequence numbers are displayed near each atom as numeric labels. 
   Try “Miscellaneous Menu >> Show Numeric Labels”. 
 
(3) Input file formation for TDDFT calculation of PC GAMESS 7.0 are supported. 
 
(4) Input file for GAMESS calculation can be reviewed and edited before calculation. 
  The base file name for calculation can be modified before calculation as well. 
 



(5) Perioric table is included.   Try “Miscellaneous Menu >> Show Periodic Table”. 

 
(6) New atom colors for X atoms (other than H, C, N, O, F, Si, P, S, Cl, Br, I). 
 
(7) Guide marker for molecular modelling.   Try “Miscellaneous Menu >> Show Guides”. 
 
(8) Molecular models of Organometallics newly created with Facio are included as samples. 
 
 
----- Ver.10.2.1 -----   Apr. 16, 2006 
 
(1) Moment inertia of a molecule is calculate and the principal axes transformation is performed. 
 
(2) Comparison of two molecule which are the identical molecule but have slightly different 

geometry is performed and the geometrical differences (bond length, bond angles and dihedral 
angles) can be saved as a text file. 

 
(3) Schematic representation of energy level of molecular orbitals are modified.  
 
(4) H-H coupling constants are extracted from Gaussian output file and saved as a texe file. 
 
(5) Molecular structure can be extracted from “finished but not converged” or “not finished” 

Gamess geometry optimization. 
 
 
----- Ver.10.1.1 -----   Mar. 5, 2006 
 
(1) Facio is now working on Linux (Fedora Core 4 and Scientific Linux 4.2)  

with a help of WINE and Mesa. 
   WINE:  http://www.winehq.com/          Mesa:   http://www.mesa3d.org/ 
 
(2) A new GUI for UTChem.  UTChem is a software package for ab initio quantum chemistry 
   calculation, developed at Hirao's Laboratory of Tokyo University. 
   http://utchem.qcl.t.u-tokyo.ac.jp/ 
 
(3) PC GAMESS(Ver.7.0), MSMS and Tinker/MM3 on Linux can be executed from Facio on 
Linux. 
 
(4) Animated graphics of normal mode vibration can be sequentially stored as JPEG files. 
 
 
 


